How to 3D Print at the DSC

A guide for new and current staff members at the DSC. This document first goes over the basics of 3D
printing, then presents some specific problems and typical prints.
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1 Choosing a Printer

Ask yourself the following questions:

o Uk wWwNPE

Does the object have a large footprint)?

Is the object thin (< 1 cm)?

Is the object really detailed?

Do all surfaces of the object need to be smooth?

Is it a two-colour print?

Has the object been requested to be made out of TPU 95a?

If the answer to any of these is yes, it should be printed on an Ultimaker. The Ultimakers are used
for 99% of all DSC jobs, while the Makerbot is used for demonstrations and at very high volume

periods only.
If the answer to question 6 is yes, it should be printed on one of the Ultimaker S5.

2 Setting Up a Print Job

Cura is used to set up prints for the Ultimaker 3s and S5s.

Cura

1.

2.
3.

Open Cura

Near the top-left corner, click on the folder icon r . Open the file(s) to be printed
Change the position of the object on the build plate.
a. Click on the object such that it’s surrounded by a blue outline and drag it around.

b. Once other tools such as Rotate are used, the Move tool E must be selected from
the left toolbar to be able to click and drag the object around again.
c. To move the object in only one direction, click and drag on the arrows instead of the
object.
Change the orientation of the object(s) (if necessary)
a. Click on the object to be rotated. Selected objects will be surrounded in a blue
outline.

b. On the toolbar at the left side of the screen, click on the Rotate icon E . Click and
drag on the rings to rotate the object.



5. Check the scale of the object by clicking the Scale icon #t . Ensure it’s the desired size. To

change the size, click on the scale % boxes or the mm boxes.

6. Change the print settings

a. Click on the toolbar in the top right corner to change the print
settings.

b. Click on the profile drop down menu and select the appropriate
profile. This changes the layer height and the print speed. The
finer profiles will tend to have a lower speed, which results in
more accurate prints.

c. Some important headings to click on and modify the settings of
if necessary are Infill, Support, and Build Plate Adhesion.

7. Once the settings are as desired, click on the blue Slice button on the
bottom right of the screen. Then click on Preview. A slider will appear
on the right side of the screen. Move the top handle down to show how
each layer of the print will be sliced.

8. Save the project by clicking File then Save. Choose a name and location
to save it to.

9. To print the file, click on the Print over network button that comes up in
place of the Preview button. Select the printer it should be printed to in
the pop-up box.

Printing with 0.25 mm Nozzle in Cura

Extra Fine - 0.0&6 mm
Fine - 0.1 mm
Normal - 0.15 mm

Fast - 0.2 mm

Quality

Shell

Infill

Material

Speed

Travel

Cooling

Support

Build Plate Adhesion
Dual Extrusion

Mesh Fixes
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Experimental

Download the custom profile from here, and save it to your local storage. Open the Cura, from
“Settings” tab on top of the window, select “Configure setting visibility”. In the opened window select
“Profiles” and then “Import”. Find the profile “Cus25” you just downloaded and import it to the Cura.

Thereafter, you can use the profile for printing with 0.25 nozzles.


https://drive.google.com/file/d/1Vkfoz9oBqRndeBQnCFvgZBwC-cYlBl5D/view?usp=drive_link

General

Profiles Import

settings

Printers Profiles compatible with active
. printer:
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Profiles
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Fast

Custom profiles

0.25 cus

0.25 exp
0.25exp 2
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0.25 Experiment
cus25

libbits
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Important things to consider when printing with 0.25 nozzle:

Using a 0.25 nozzle would not necessarily result in a considerable increase in resolution in Z
plane or vertical plane. That is because your layer is not changing. Rather, the most
substantial difference would be in horizontal plane or XY resolution.

Decreased speeds would always help get a better result due to less chance for over shoot.
Try not to print large models with a 0.25 nozzle as it is not reasonable to do so, miniature
models however may need a 0.25 nozzle to maintain a good resolution.

It is a good practice to keep the line width of the print be equal to the nozzle diameter, that
is, printing with a 0.25 nozzle requires a line width of at least 0.25 mm.

Placing Multiple Prints on the Build Plate
Cura will try to fit all of the objects on the build plate but sometimes they’re placed off the build
plate. If the opened object(s) do not appear then zoom

Configurations

out until they appear. Drag them onto the build plate.
Ultimaker 3
If several copies of the same object are to be printed on
one build plate, then: > M 2 Natural PYA
1. InCura, add the object to the buildplate
2. Right click on the object
3. Click on Multiply Selected Model Y rin =
4. Enter the number of additional objects

Custom >




5. Click OK

PVA Supports
PVA dissolvable supports are used on parts with lots of detail, or parts that need to replicate real-life
organic shapes like bone. Please return the PVA roll to a sealed dry bag when the print is complete!

Note: You may desire printing with supports that are mostly PLA, with PVA forming a dissolvable
interface where they touch the part. Settings for this method are in Step 5 of the instructions below.

PVA Interface Pros:
® PVA can be very stringy and sometimes unreliable when printed as a tall support
e Reduce the time of the print
e Reduce the cost of the print
® Good for medium-large parts
PVA Interface Cons:
e Removal of such supports may be difficult if they are caught inside the part. Bad for tiny
Heroforge D&D miniatures.
e The PVA can take longer to dissolve, as less surface area will be exposed to water.

The thickness of the PVA interface can be increased if you need to remove the supports from an
intricate surface and want the PLA to be relatively loose when the PVA is dissolved.

a

(Before water) (Don’t print with pointy ends pointed down!)

(before water) (after)
This print turned into spaghetti with 100% PVA supports, but removing the partial PLA supports
nearly broke its ankles. Could be remedied with a thicker PVA interface.



1. To print with PVA, the printer must be setup properly and be represented accurately in the
settings

a. On the printer, Printcore 1 should be loaded with a AA 0.4 nozzle and be loaded with
PLA. Printcore 2 should have a BB 0.4 nozzle and be loaded with PVA.

b. In Cura, click on the Prepare tab at the top of the screen. Click on the material bar
immediately under the Prepare tab and a Configurations window will pop up. If one
of the printers is set up using the instructions in step 1.a then select that printer. If
neither of the printers can be setup like in step 1.a (due prints currently ongoing,
etc.) then click on the Custom button and replicate the settings in step 1.a.

In the Print settings menu, click on the Support tab

. Ensure Generate Support is checked k. Support ~
H Gi 5 &
4. For 100% PVA Supports: Click on the Support et 2uppert v
Support Extruder é) Extruder 1 ~

Extruder drop-down menu and select Extruder 2 _ _
Support Placement &

from the list. The default settings for PVA are nearly  <.;por overnang angie & | Extruder2
always sufficient. Skip to Step 6 Suppart Density FRT:

5. For PLA Supports with PVA touching the part:

a. Click the stack dropdown menu next to the Search settings bar.

b. Select Expert or All.

c. Click on the Support Interface Extruder drop-down menu and select Extruder 2 from
the list.

d. Change the Support Interface Thickness to 1.5mm (Check that Floor Thickness and
Roof Thickness match)

6. One more consideration when printing with PVA (or any print with two filaments) is adding a
prime tower. This is useful for preventing underextrusion, oozing, and feeders grinding the
filament. Use a prime tower for prints where not much filament is printed during each layer.

a. Inthe Print settings menu, click on the Dual Extrusion tab

b. Check Enable Prime Tower

c. If the location of the tower interferes with the print (or you want it closer to reduce
printhead travel time) then it can moved by adjusting the X and Y positions

TPU 95a

TPU 95a is a flexible filament so it presents unique challenges compared to PLA. Since the feeder and
the nozzle are separated by a significant distance, when the feeder tries to retract the filament it may
not succeed in pulling the flexible filament away from the nozzle. This results in a lot of stringing and
overall not a clean print if lots of retraction is needed. TPU 95a is best used for objects requiring
flexibility that are also continuous and don’t require support. Both Ultimaker and generic TPU work
well, in both cases it is recommended to increase the temperature (see possible settings for odd
filaments) to reduce blockage.

1. To print with TPU 953, the printer must be setup properly and be represented accurately in
the settings. Since the S5s have filament sensors, it is highly recommended to send jobs
requiring TPU95 to these printers.

a. On the printer, Printcore 1 should be loaded with an AA 0.4 nozzle and TPU 95a.
b. In Cura, click on the Prepare tab at the top of the screen. Click on the material bar
immediately under the Prepare tab and a Configurations window will pop up. If one



of the printers is set up using the instructions in step 1.a then select that printer. If
neither of the printers can be setup like in step 1.a (due prints currently ongoing,
etc.) then click on the Custom button and replicate the settings in step 1.a.
2. The default TPU 95a settings provided by Cura work well most of the time. Some print
settings that can be adjusted are:
a. Profile: the layer height and speed will be changed based on the chosen profile.
Note: The smallest layer height that works well with TPU 95a is 0.1 mm.
b. Build plate adhesion: the default brim can be replaced with a skirt if need be. The
brim is more difficult to remove with TPU 95a than with PLA.
c. Speed:15mm/s
3. Supports
a. For projects requiring TPU95a and support, it is
possible to use both PVA and PLA supports. PVA
supports are very difficult to print with and only
work well if the supports are directly on the
build plate.

i For supports that need to be built on an
existing part of the model, this type of
support is very unreliable and does not
produce good results (left of the image
vs right part of the image).

b. PLA supports, however, work very well with TPU95a.
To use this type of support, we need to use two AA
0.4 print cores.

i.  The final printed model does require
clean-up, yet these are much easier to
remove compared to TPU supports and the
colour can be matched in order to make any
imperfection less visible. In the above
photo, supports have been removed from the right part of the model (with
the overhang) and leave a clean finish. On the left part of the model,
imperfections have not yet been removed, but can easily be cleaned up with

a pair of pliers.

For more possible settings:
https://docs.google.com/document/d/105HRDP38VRsMucnhgIXIN5IIWPkOx732bZCmRBOw7w8/edi

t?usp=sharing

PETG

PETG and r-PET are materials that are more heat resistant than PLA, but are a little more stringy. The
DSC has both brand-name and generic PETG filament, both work well. When using PETG, make sure
to use the PETG settings available on Ultimaker Cura. These settings work well, for all brands of
filament we carry, but it can be beneficial to increase slightly the temperature (increase by 5 degrees
as needed) to reduce clogs.


https://docs.google.com/document/d/1O5HRDP38VRsMucnhgIXIN5IlWPkOx732bZCmRBOw7w8/edit?usp=sharing
https://docs.google.com/document/d/1O5HRDP38VRsMucnhgIXIN5IlWPkOx732bZCmRBOw7w8/edit?usp=sharing

Currently, PETG is only offered in white, red, black (PETG) or translucent blue (r-PET) and costs
10c/gram.

Two-Colour Printing
Printing with two colours of PLA is used when two colours are needed in the same object. It’s not
requested very often by students but it’s fun to know.

1. To print with two colours of PLA, the printer must be setup properly and be represented
accurately in the settings
a. On the printer, both printcores should have an AA 0.4 nozzle and be loaded with PLA.
b. In Cura, click on the Prepare tab at the top of the screen. Click on the material bar
immediately under the Prepare tab and a Configurations window will pop up. If one
of the printers is set up using the instructions in step 1.a then select that printer. If
neither of the printers can be setup like in step 1.a (due prints currently ongoing,
etc.) then click on the Custom button and replicate the settings in step 1.a.

2. Fortwo-colour printing, the object must be
imported as two different objects, one for each
colour to be printed. When they are initially placed
on the buildplate, they probably won’t be aligned.
Alignment methods will vary depending on the
shape of the objects and how they will fit together.
Some methods include:

a. If the centers of both parts should be

aligned, then click on the Move tool E
and enter “0” for all coordinates

b. If the objects are offset from each other by
a known amount, then click on the Move

tool B and change the coordinates to the known values

c. Ifit’s a “flexi” object, use the Move tool 24 to drag the objects into an orientation iz

where the connecting pieces do not interfere with each other A0 )
3. By default, both objects will be set to be printed with Extruder 1. Click on the object that |”|
will be printed in Extruder 2’s colour. On the toolbar on the left of the screen, click on the
Print Selected Model with Extruder 2 icon u

4. Continue as usual with the rest of the print setup.
Support Blocker (Cura) g

The Support Blocker is a function in Cura where you can turn Supports on but then block supports
from generating in certain areas. It’s a bit awkward to work with, but can be useful. Makerbot Print
has a setting that enables you to turn off supports under bridges that will
not need supports, but Cura does not have this option. So, an object such as
this milk crate would end up having extensive, unnecessary supports.

1. First, run a print preview to see where supports will generate and
where you might need to prevent supports from building. As you
can see to the right, this crate has extensive supports generated,




Spiralize/Vase Mode (Cura)
This mode allows you to print just the outside wall of an object to create a

which would be a waste of material and require a lot of time to clean up.

Go back into Prepare mode. Click on Support Blocker. (Note: if you have Slice Automatically
turned on, you will want to turn it off for this. You can do that in Cura Preferences.) Start
clicking on all the areas where you want there to be no supports. Little translucent boxes will
appear. These are the support blockers. You only need to put them on the overhangs. They
can overlap each other, so when in doubt, you can add lots of them.
To remove a blocker, simply click on it again.

To the right is an image example showing one side of the crate with
blockers placed and then a print preview to show the difference
with just one side having blockers applied. There should be supports
in the handle of the crate at this scale, so if this object were going to
be printed, the blockers would need to be removed at that point of
the model.

fully hollow, thin object. Not something often called for, but more likely to
be asked for when someone is looking to create something that they want  spiral
light to be able to get through or when trying to get as clear as possible

when using translucent material (such as when printing a bottle),

Z. Special Modes

. . . . . Spiralize Outer Contour P
especially if the model was not designed hollow. Note: this will not create rp e ¢

a strong model as it will only create one wall.

1.
2.
3.

Tree Supports (Cura)
Cura has an alternate type of support called tree supports that can greatly
reduce the time and support material use of some prints while still

Insert model

Search for “spiral” in the print settings

Check Spiralize Outer Contour. This should auto-select Smooth
Spiralized Contours

Run slice and check Preview. You can see from the before and after
to the right that the model is now hollow.

|II

providing adequate support. Rather than printing uniform scaffolding,

supports are printed as hollow tubes with fractal-like arms or branches giving them the appearance
of trees. An ideal situation to use tree supports is a print consisting of a thin convex shape with a
large gap in the middle such as a full face mask.

TIME ESTIMATION
Infill:

Inner Walls:
Quter Wall:
Retractions:

Skin:

Skirt:

Support:

Support Interface:
Trawvel:

MATERIAL ESTIMATIOMN

PLA
PVA

— TIME ESTIMATION
bo-oo De Infill: 00:00 0%
00:32 5% Inner Walls: 00:32 Bt
0047 Tag Cluter Wall: 00:47 12%
02:04 19% Retractions: 01:29 23%
00:18 3u Skin: 0018 5%
0022 35 Skirt: 0023 B9
05:45 2% Support: 02:20 36%
00:49 7% Support Interface: 00:09 EL™
00:24 Ay Travel: 00-23 B%
MATERIAL ESTIMATIOMN
357Tm 28Z2g £0.00 PLA 3.55m 28.1g £0.00

6.99m 5493 €0.00 PVA 2.B5m 223g €000



However, tree supports do not always offer an advantage as seen in the next example.

Things to consider while using tree supports:

a.

o

In case of low computing power, it may be harder for Cura to slice complex models with tree
supports a it requires a lot of calculation in contrast to normal supports which are vertical
pillars.

On models with a large flat surface the normal support may still be a better option.

Do not use tree supports when printing PVA. PVA is susceptible to failure as it is sensitive to
humidity, which most often would result in underextrusion. Combined with hollow trunks in
tree supports, it would not result in a perfect support.

Brittle filaments (e.g., PVA) are more likely to fail when using tree supports with thin walls as
they may break easily during travel.

With prints that require high tree branches for printing, increasing brim or infill density for
the supports to 10% would be helpful as it woul prevent the trees brom breaking or falling.

To enable tree supports:

1.

Navigate to supports in print settings and click on the three sliders icon to view the setting
visibility.

Under support settings, check “Support Structure”.

With the support structure settings now listed, click the drop down menu and select “Tree”.
Upon slicing, the print will now use tree supports.



Per Model Settings (Cura)
In some cases there will be many small prints in the que that require the same material and layer
height, but not the same infill density or choice of dual extrusion for supports. By using Cura’s per
model settings feature, it is possible to print these parts at the same time.
1. Prepare the global print settings as usual.
2. Select a part that requires different print settings.
3. Click the “Per Model Settings” button on the left side of the Cura window. It has an icon
consisting of four differently shaded squares. Then click “Select Settings”.
4. Check any settings that need to be changed in the popup window that opens, then change
their values in the per model settings tab to the left.
5. Repeat steps 2-4 for any other parts requiring different settings from the rest of the print.

Split Multi-Part Models (Cura)
On rare occasions, a user will submit a 3D model made of separate parts that are arranged too
awkwardly to print. There is a plugin that allows these to be split into independently moveable
objects.
1. Download the latest release of the Cura plugin Mesh Tools if it is not already installed under
the “Extensions” tab.

Extensions Preferences Help
Update Checker >
Cura Backups »
13 Post Processing >
Mezsh Tools ¥

2. Dragthe downloaded file into the Cura window.
3. Right click the multi-part object, go to “Mesh Tools”, and click “Split model into parts”.

1 | -
Mesh Tools > Reload model
Center Selected Rename model...
Delete Selected Del Replace model..
Multiply Selected Crri+m Check mesh

Analyse mesh

« Extruder 1: PLA - AA 0.4 Ctrl=1 Fix simple holes
Fix model normals
Select All Models Crrl+a S T I s
Arrange All Models Crri+R Randomise location
Clear Build Plate Ctri+D Apply transformations to mesh

Reload All Models F5 Reset origin to center of mesh
Reset All Model Positions
Reset All Model Transformations


https://github.com/fieldOfView/Cura-MeshTools/releases

3 Common Printing Issues

In this section, a few of the common issues experienced at the DSC will be discussed. A google search
for any of these problems will come up with a ton of results and some of them go really in-depth.
This section is just a quick guide to common issues, it is in no way a complete list.

Print Lifting Off the Build Plate

Objects will sometimes peel up at the corners while printing.

Since the Ultimakers have heated build plates and the DSC only prints with easy filaments this isn’t
much of an issue. A thin layer of hairspray is used to help with build plate adhesion so if a print isn’t
sticking it’s probably time to reapply. When lifting does occur, it’s typically when printing a much
larger object than usual, where at the edges there isn’t as much hairspray.

Underextrusion

Underextrusion is when filament is being
printed but less than the expected volume flow.
It can be seen most easily as holes in the
normally solid walls of the infill pattern. The
example to the right shows a print where the
temperature was set too low and had to be
restarted.

There are several reasons why underextrusion

would happen on an Ultimaker. The first is the temperature being set too low. The PLA at the DSC
prints best at 200-205 degrees celsius. It’s possible for the print temperature to accidentally be set
lower in Cura. The second is there being a partial clog of the nozzle. With the AA 0.4 nozzles, they do
not require cleaning very often because printing PLA doesn’t produce a lot of buildup inside the
nozzle. The BB 0.4 nozzles on the other hand get clogged often enough because the PVA will
carbonize inside the nozzle. One way to avoid this is to unload the PVA filament when it’s not in use
because even when only printing PLA, the PVA nozzle will still be heated up to about 40 degrees,
causing carbonation. Underextrusion in both nozzle types can be fixed by doing a series of “hot pulls
and “cold pulls”. This can be accessed on the printers by going into the “Maintenance” section on the

”

user interface.

No Extrusion

Sometimes chronic underextrusion will
lead to a complete stop in filament
extrusion, or extrusion could stop all of
a sudden. To the right is an example of
an “all of a sudden” no extrusion case.

The simplest cause to this problem is
there’s no more filament on the spool.
The solution is to restart the print with




a new spool of filament because unfortunately the Ultimaker 3 printers don’t pause the print when
they run out of filament (however, the Ultimaker S5 does pause).

Another cause is that the filament is stuck on the way to the feeder which the feeder cannot
overcome with its strength. This can happen if there are two filaments on the spool holder and the
filament guide isn’t used. Also, it can happen when the windings of the spool get tangled. The
solution to these problems is varied, for example putting on the filament guide or untangling the
spool.

Sometimes a partial clog can turn into a full clog and prevent any filament from extruding. The fix is
the same as with underextrusion.

To unclog a print core, follow the instructions found_in this video including doing a hot pull, a cold
pull, and as a last resort, using the cleaning needles.

4 Maintenance Procedures

XY Calibration

To ensure the accuracy of material placement with dual extrusion, you should run an XY calibration
whenever a print core is changed. You should be prompted to run an XY calibration after loading a
new print core, however you can run one any time by going to SYSTEM -> Maintenance -> Calibration
-> Calibrate XY Offset

The printer will print single layer calibration strips for the X and Y axes for the next ~20 minutes. After
the print is complete, carefully remove the glass build plate and place it over one of the calibration
sheets found on the shelf at the back of the 3D printing / storage room. Choose an offset that lines
up with the most collinear pair of opposite extruder lines.

Ultimaker XY Calibration Guide

Play on Axles

* If you notice some play on only one of the axles, you can try to fix it by following the steps below.
However, if the play is too much, or more than one axle is affected, you should realign the axles
instead (see Axle Alignment). Do not over-tighten the pulleys, as this can make the print head shafts
not perpendicular to each other, and affect the print quality.

The pulleys are responsible for locking the X and Y axles in their positions. However, over time, some
of the pulleys may become slightly loose due to wear and tear or other factors. This can affect the
alignment of the axles and cause them to have some play or movement. This can lead to problems
with the print quality, such as inaccurate dimensions, poor surface finish, or layer shifting. It is
recommended to check for play on the axles at least once every three months.

In case of minor play:

First check which of the axles has play.

Loosen the pulleys on that axle. Note that the set screws of the pulleys are not always easily
reachable. Adjust the position of the print head until you can reach the set screws. Loosen
them, but do not remove them from the pulleys completely.

Correctly position the axle:

The X axles should be positioned in the middle.

The Y axles should be pushed toward the front of the printer.


https://www.youtube.com/watch?v=INX-Ih1YTvs
https://support.makerbot.com/s/article/1667337567556

While ensuring that the axle stays in place, firmly push the pulleys toward the frame.
Tighten the set screws. Make sure the pulleys are tightened securely. If they are too loose,
this can lead to print quality issues such as layer shifting.

Axle Alignment

To print accurately, the print head shafts need to be perpendicular to the X and Y axles in the frame.
This means that they form a 902 angle with each other. If the print head shafts are not aligned
properly, this can distort the dimensions and shape of your print. You should calibrate the printhead
and align its axles if you notice this problem, or if you have considerable play on the axles.

You will need the following tools:

A 2.0 hex screwdriver or a ball-head screwdriver

A 0.5 Nm torque screwdriver (optional, but recommended)

Two calibration sticks (one for the X axle and one for the Y axle)

Depending on your printer model, you will need different sizes of calibration sticks for the X
and Y axles. For the Ultimaker S3 and S5, you will need an 8mm calibration stick for the X
axle and a 10 mm calibration stick for the Y axle. For the Ultimaker 2 family and the
Ultimaker 3, you can use the same calibration sticks for both axles.

Find the complete guide here, follow the procedure step by step as explained. A good case scenario
could be found in Ada Troubleshoot documentation in here.

Bed Level Issues

If gaps were present between lines (as could be seen in the first layer), then the printer needs
maintenance. There is a good chance that consistent gaps could be due to underextrusion, however,
if you are sure that underextrusion is not the problem or the gaps are inconsistent, then another
possibility is that the bed is not correctly levelled. It is important to make sure that the bed is level
every once in a while. To understand the current status of the bed level, follow the steps below;

1.

2.

Make sure you have the plugin/extension “Calibration Shapes” by Saxes installed on Cura.

Calibration Shapes 224 ]
<

This plugin adds a menu to create some basic shapes to the scene (cube, cylinder, tube, sphere) and standard test

parts. .

By Saxes [3 Uninstall

Open a new empty project, head to “Extensions” -> “Parts for calibration” -> “Add a bed level
calibration”.


https://support.ultimaker.com/s/article/1667412443401
https://drive.google.com/file/d/1PLCddNbZ_14FqMYTTY5mfBb8y_5LWBgW/view?usp=drive_link

Extensions Preferences Help

Update Checker >
Cura Backups >
d Post Processing > . £ Generic PLA
Part for calibration > Add a cube
Mesh Tools > Add a cylinder

Add a sphere
Add a tube

Add a Calibration Cube —

Add a PLA TempTower

Add a PLA TempTower 150°C
Add a PLA+ TempTower

Add a PETG TempTower

Add an ABS TempTower

Add a PC TempTower

Add a Retract Tower

Add an Acceleration Tower

Add a Retract Test

Add a XY Calibration Test

Add a Dimensional Accuracy Test
Add a Tolerance Test

Add a Hole Test

Add a Bridge Test

Add a Thin Wall Test

Add an Owerhang Test

Add a FlowTower Test

Add a Flow Test

Add a Max Flow Test

Add a Multi-Flow Test

Add a Support Test

Add a Lithophane Test

Add a Bed Lewel Calibration

Add a Linear/Pressure Adv Tower
Add a Cube bi-color

Add a Bi-Color Calibration Cube
Add an Extruder Offset Calibration Part

Define default size

Help

3. Notice that a calibration model is added on your print bed, and that this model would be
different depending on the printer size.
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4. Change the print setting to the following setting and print the model:
- Nozzle Size : 0.4
- Initial Layer Height : 0.2
- Line Width : 0.4
- Wall Line Count : 3
- Fill Gaps Between Walls (Only for release of Cura previous to V5) : Nowhere
- Build Plate Adhesion Type : None
- Initial Layer Speed : 20 mm/s
- Outer Before Inner Walls: True
5. After printing is done, check for gaps between lines and find out which sides of the bed need
to be lifted in order to eliminate the issue. You can increase/decrease the bed height by
slightly playing with screws below the bed.
6. If the issue still exists or there are multiple regions with gaps, consider doing a complete
manual bed levelling from the maintenance settings of the printer.

5 Examples of Prints

The examples presented are to give a sense for the different settings and why certain settings are
used in specific cases. Any of these items that were printed on a Makerbot could also have been
printed on an Ultimaker, unless otherwise specified.

Workshop Activities

The workshop activities (particularly the Keychain activity) are some of the most common things
printed at the DSC.

Keychain
Printer Used: Makerbot
Settings Profile: Balanced (0.2 mm layer height)



Infill: 20% (default)
Support: PLA
Special Settings: None

This is usually the simplest, easiest print. Since this is often the very first 3D object someone designs,
it’s worth thoroughly looking it over. The most common problem is that the letters don’t touch
enough to print as a strong object. Turn supports on because some of the letters are often placed
higher than the others by mistake and Makerbot won’t print a raft under those areas (top left
picture). With supports turned on then a raft is printed under the whole object (top right picture).

Phone Stand Keychain

Printer Used: Ultimaker

Settings Profile: Normal (0.15mm layer height)
Infill: 20% (default)

Support: None

Special Settings: Used a skirt instead of a brim




This would print fine on the Makerbots but the heated build plate of the Ultimakers makes for a nice
finish on this part. The Normal profile takes a little longer than the Fast profile but gives the part a
“smooth” finish. Infill doesn’t matter. This part has a lot of surface area on the build plate so it will
stick just fine without a brim but a skirt is needed to prime the nozzle well. The skirt requires no
post-processing of the part compared to a brim, which can be difficult to remove cleanly.

Dice

Printer Used: Makerbot

Settings Profile: Balanced (0.2 mm layer height)
Infill: 10% (default)

Support: None

Special Settings: None

If support is enabled then there will be support material printed in the letters which is difficult to
remove. The minor deformation from not having support looks better than scratch marks from
removing support.

Chess Pawn

Printer Used: Makerbot

Settings Profile: Balanced (0.2 mm layer height)
Infill: 10% (default)

Support: PLA

Special Settings: None



Wand

Printer Used: Ultimaker

Settings Profile: Normal (0.15mm layer height)

Infill: 20% (default)

Support: None

Special Settings: Extra wide brim and slowing down the print speed halfway through the print
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This print can be finicky because the printhead has a tendency to knock over one of the wand halves
when rapidly moving between them. Make sure the student has sent the wand as separate files
because it may be more reliable to print them one at a time. The brim is 12mm wide to prevent the
tall objects from lifting off the build plate when the print head moves between the parts. On the



Ultimakers the print settings can be edited as it prints so the speed is lowered to 70% of the original
speed about halfway through the print to reduce the chances of the parts lifting off the bed.

Lego

Printer Used: Ultimaker

Settings Profile: Normal (0.15mm layer height)

Infill: 20% (default)

Support: None

Special Settings: Used a skirt instead of a brim and turned the speed down to 60 mm/s

72

The lego should really be printed with supports but it would be too difficult to remove from the
interior so a poor-looking inside is the compromise. If true dimensions are desired, slow down the
normal profile to 60 mm/s. The Makerbots with default settings can also be used if the dimensions
don’t matter too much.

Non-Workshop Print Examples

These examples are provided to give a broader scope of the types of print jobs the DSC handles.

Dungeons and Dragons Miniature

Printer Used: Ultimaker

Settings Profile: Extra Fine (0.06mm layer height)
Infill: 20% (default)

Support: PVA

Special Settings: Enable Prime Tower




Miniature models for Dungeons and Dragons, or other role-playing games, are fairly popular. The files
usually come from a website called Heroforge as pictured on the left. These files need to be printed
on an Ultimaker because of the fine detail and PVA support (middle picture). If printed at the scale
that Heroforge defaults to, not all of the detail will be visible (right picture) but it still looks pretty
good. If there are several figures being printed at once then a prime tower is not needed.

Weird-Shaped Thing

Printer Used: Ultimaker

Settings Profile: Fine (0.1mm layer height)
Infill: 10%

Support: PLA

Special Settings: None
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The student requested a fine layer height because this was a part of an art project, so they didn’t
want to see the 3D printing lines in the model. Otherwise, a larger layer height would have been fine.
The default orientation (top left) initially seemed good for this object, until scrolling through the
object showed the bottom of the ripples being printed on spindly supports. This would normally be
ok but since the student wanted a good surface finish the orientation was changed (bottom). One
might ask: if they wanted a good surface finish why not use PVA support? The answer is to save
money, sandpaper is cheaper than PVA.


https://www.heroforge.com/

Print Blocks

Printer Used: Ultimaker

Settings Profile: Normal (0.15mm layer height)
Infill: 10%

Support: PLA

Special Settings: Various
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Print blocks are a part of Tiffany’s art history workshop. The settings for each print are different since
each design presents unique challenges. If the design isn’t very detailed, it can be printed entirely in
TPU 95a with the design facing up (left picture). If the design is more detailed it may be better to
print it upside down in two filaments; TPU 95a for the design and PLA for the base and support (right
picture). The only consistent setting is using the Normal layer height but reducing the speed to
whatever the fine setting’s speed is.

N

RC Bronco Prints

Printer Used: Ultimaker/Makerbot
Settings Profile: Fine (0.1mm layer height)
Infill: 10%

Support: PLA

Special Settings: None

Most of the objects in this print could be made on the Ultimakers without issue (left picture). They
had fine detail but only needed one side to look good since they were going in an RC car so PLA
supports were sufficient. There was one piece that was too large to fit on the Ultimaker build plate so
it needed to be made on the Makerbot (right picture). It would have been preferable to have the
student split the piece in half so it could be printed on an Ultimaker but this student had no
experience with 3D design and was unwilling to try. The print-lifting-off-the-build-plate issue was
explained to them and they agreed to take the risk. It turned out well because on all the edges of the



print there was a large amount of support material so the lifting only affected the supports and not
the actual object.

Scythe

Printer Used: Makerbot (Replicator+)

Settings Profile: Balanced (0.2 mm layer height)
Infill: 10% (default)

Support: PLA

Special Settings: None

This is a good example of larger objects that might be printed on the Makerbots to prevent
unnecessarily making the Ultimaker queue longer. Four objects join together to make a scythe that
can be attached to a handle of a wood dowel. Because it’s mainly for form, the print doesn’t need to
be precise, making it perfect for the Makerbots. The Replicator+ was chosen because the objects
were too long for the Replicator 5th Gen. The print did lift a little at the ends but since all the objects
are curved, there was support material printed in those areas so by the time it was printing the real
object it had self-corrected for the lifting.

Problematic Print Requests

These are print requests that either got denied or that were printed but had problems with them.

Thin Detail

This print was requested to be made 5 cm tall using PLA supports. The PLA supports would be
somewhat inconvenient to remove but the main issue is the headband with the star. The headband
itself is not connected to the head, so it wouldn’t be attached well when printing. Also the star is too
thin to be printed and the small amount that would is not connected to the headband. You can see in
the print preview that the outer edges of the star are greyed out, indicating that it will not be fully
printed. Dragging through the print preview layers showed the lack of connection between the
crown and the head (lower image). The student was asked to increase the thickness of the headband
and star but they never replied.



License Plate Standoff

This is an object that should be printed on an Ultimaker but had to be printed on the Replicator+
because it was too long. The student specified that they didn’t want the object split into two pieces.
It was printed on the Replicator+ and one corner lifted off significantly from the build plate. It should
have been made more clear to the student that lifting was definitely going to happen if it wasn’t split
into two pieces.

¥ Diait:

Small Text

Text is common in TinkerCAD objects but when designing it’s difficult to judge how big the text needs
to be in print well. This is an example of an object that looked like the text was on the small side but
it might still print ok. It did not turn out well (top-right picture) due to the Makerbot not being able
to keep up with all the small radii in the text. There was larger text on the other side of the object
that turned out well (bottom-right). The student changed their design to have larger text and it was



printed on an Ultimaker. The object turned out quite well after that but unfortunately there is no
picture of it.

Melting Clock

This is a great example of a non-intuitive orientation for printing. The L-shape combined with
detailed features on the outside mean the ‘obvious’ orientation (face-down) won’t work well.

Seems ok at first, but you can see the large area of support required underneath - this would be a
nightmare to remove, the clock face won’t look very nice and it wastes material.



This orientation preserves the fine clock face features, but uses too much support.
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By printing the clock this way, we use minimal support and keep the clock face turned upwards for
best results. The tilted angle of the faces are gradual enough to not need support underneath.

6. MakerBot - Everything you need to know

Setting up a print job
Makerbot Print is used to set up prints for the Replicator+.
1. Open Makerbot Print
2. At the bottom right of the screen, click on the Printers bar. Select which printer this print will
be executed on. Some things to consider are print time, print size, and the currently loaded
filament colour. The Replicator+ prints quicker and has a longer print bed.

3. Inthe top left corner, click on the folder icon il . Click on the Add Models icon . Select
the file(s) you would like to print and then click Open. One or more objects should now be
placed on the build plate.

4. Change the position of the object on the build plate by clicking and dragging it around.

5. Change the orientation of the object (if necessary).

a. Clicking the Orient icon ‘:’ .
Click on the +90 and -90 buttons or enter custom angles.

c. A specific face can also be defined as the reference for orientation by clicking the
Place Face on Build Plates button.

d. The part should be oriented such that it uses the least amount of support material
possible and any critical faces/features do not have support on them.

6. Check the scale of the part by clicking the Scale icon al . Ensure it’s the desired size. To
change the size, click on the scale % boxes or the mm boxes.

B Quick Settings

E Printer

B  Extruder



7. Change the print settings.

a. Click on the gearicon Q to bring up the print settings toolbar.
Click on Custom Settings. Click on Quick Settings. The important settings to take note
of here are the layer height, infill density, and the number of shells. They can be
changed if necessary.

c. If the part needs support, then click on the Supports + Bridging tab. Scroll to the
bottom. Under Support Type, select Breakaway Support from the drop-down menu.

d. Atthe bottom-right of the window, click Done. Click on the gear icon to hide the
settings.

8. Click on the clock icon & to start estimating a print preview. The software will now slice
the object(s) into layers. Once it’s finished a slider will appear on the left of the screen that
can be moved up and down to show how each layer of the object(s) is printed.

9. Save the project. Click File, then click Save As... and choose a name and location.

10. Print the project. At the bottom right of the screen, click the Print button, then make sure
the build plate is clear and click Start Print.

Sending your file by USB

11. If sending your project through a USB stick, the file needs to be saved with all required print
settings, as a .makerbot file.

12. Insert the USB stick in the designated area on the printer, select the file you want to print
and hit start. Once the print has started, the USB stick can be removed as needed.

Placing Multiple Prints on The Build Plate
Opening several files may cause some of the objects to be placed on new build plates. They can be
copied to the first build plate by:
1. Clicking on the build plate they are on
Clicking on the object
Pressing Ctrl+c
Clicking on the first build plate
Pressing Ctrl+v
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Common Issues

Lifting
Lifting is an extremely common problem on both Makerbots. They don’t have heated build plates so
the tendency of prints to lift depends more on environmental factors such as the room temperature



and humidity. Winter conditions provide a higher susceptibility to lifting due to cooler indoor
temperatures. Some quick fixes are to apply new painter’s tape to the build plate (Replicator 5th
Gen) or to clean the build plate with isopropyl alcohol (Replicator+). On the Replicator+, if even small
prints are lifting, it may be time to replace the adhesion sticker on the build plate. If these fixes don’t
help with build plate adhesion then it’s best to print the job on an Ultimaker.

Under Extrusion

There’s a fairly common problem with the Replicator+ where, when printing the first layer of
filament, it will throw a “filament slip” error, recover from it automatically, then repeat the error
several more times. Sometimes it will go through enough cycles of the error that it will cancel the
print. The “filament slip” is due to a bend in the build plate that causes the nozzle to be really close
to the build plate in a certain location, preventing filament from being extruded. Since the
Replicator+ can detect if filament is moving through the nozzle, it throws an error. The quick fix for
this is to remove the build plate, clear any small bits of plastic from under it, replace the build plate,
and restart the print. The long-term fix is to replace the build plate.

No Extrusion

The Makerbots can sense when there is no more filament left and will conveniently unload the
remaining bit of filament and pause the print. More filament can then be loaded and the print can be
resumed.



